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          Adobe Acrobat Reader  
 

Finding Words 
 

You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 

including text in form fields. 
 

To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 

2. Enter the text to find in the text box. 

3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 

the box.  For example, if you search for the word stick, the words tick and sticky will 

not be highlighted. 

 

Match Case finds only words that contain exactly the same capitalization you enter in 

the box. 

 

Find Backwards starts the search from the current page and goes backwards through 

the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 

        

To find the next occurrence of the word, Do one of the following: 

            

            Choose Edit > Find Again  

            Reopen the find dialog box, and click Find Again.  

            (The word must already be in the Find text box.) 

 

Copying and pasting text and graphics to another application 
 

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 

document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 

can switch to another application and paste it into another document.   

 

Note:  If a font copied from a PDF document is not available on the system displaying the 

copied text, the font cannot be preserved.  A default font  is substituted. 
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To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 

       To select a line of text, select the first letter of the sentence or phrase and drag to 

       the last letter.   

 

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 

(Mac OS) as you drag across the width of the document.  

        

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 

(Mac OS) as you drag the length of the document. 

         

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 

on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 

in the document is selected.  When you release the mouse button, the selected text is 

highlighted.  To deselect the text and start over, click anywhere outside the selected text.   

The Select All command will not select all the text in the document.  A workaround for this 

(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 

text to the clipboard. 

 

2. To view the text, choose Window > Show Clipboard 

 

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 

Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 

Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 

Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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METROPOLITAN TRANSPORTATION COMMISSION 1 

ADMINISTRATION COMMITTEE 2 

WEDNESDAY, AUGUST 12, 2020, 9:05 AM 3 

 4 

FEDERAL D. GLOVER, CHAIR: THANK YOU. THIS IS CHAIR GLOVER, CAN 5 

I HAVE THE PLAYING OF THE ANNOUNCEMENT? DUE TO COVID-19, THIS 6 

MEETING WILL BE CONDUCTED AS A ZOOM WEBINAR. PURSUANT TO THE 7 

PROVISIONS OF THE GOVERNOR'S EXECUTIVE ORDER N-29-20, WHICH 8 

SUSPENDS CERTAIN REQUIREMENTS OF THE BROWN ACT. THIS MEETING 9 

WILL BE WEBCAST ON THE MTC WEB SITE. I WILL CALL UPON 10 

COMMISSIONERS, PRESENTERS, STAFF, AND OTHER SPEAKERS BY NAME 11 

AND ASK THAT THEY SPEAK CLEARLY AND RESTATE THEIR NAMES BEFORE 12 

GIVING COMMENTS OR REMARKS. PERSONS PARTICIPATING VIA ZOOM AND 13 

WEBCAST WITH THEIR CAMERAS ENABLED ARE REMINDED THEIR 14 

ACTIVITIES ARE VISIBLE TO VIEWERS. COMMISSIONERS AND MEMBERS 15 

OF THE PUBLIC PARTICIPATING BY ZOOM, WISHING TO SPEAK SHOULD 16 

USE THE RAISED HAND FEATURE OR DIAL STAR NINE AND I WILL CALL 17 

UPON YOU AT THE APPROPRIATE TIME. TELECONFERENCE ATTENDEES 18 

WILL BE CALLED UPON BY THE LAST FOUR DIGITS OF THEIR PHONE 19 

NUMBERS. AND IT IS REQUESTED THAT PUBLIC SPEAKERS RESTATE 20 

THEIR NAMES AND ORGANIZATIONS, BUT PROVIDING SUCH INFORMATION 21 

IS VOLUNTARY. MEMBERS OF THE PUBLIC WISHING TO ADDRESS THIS 22 

BODY WERE ASKED TO SUBMIT COMMENTS IN WRITING AT 23 

INFO@BAYAREAMETRO.GOV. WRITTEN COMMENTS RECEIVED WILL BE 24 

POSTED TO THE ONLINE AGENDA AND ENTERED INTO THE RECORD BUT 25 
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WILL NOT BE READ OUT LOUD. IF AUTHORS OF THE WRITTEN 1 

CORRESPONDENCE WOULD LIKE TO SPEAK, THEY ARE FREE TO DO ON THE 2 

REFERENCED AGENDA ITEM OR ANY TOPIC THEY CHOOSE. SPEAKERS 3 

SHOULD RAISE THEIR HAND, AND I WILL CALL UPON THEM AT THE 4 

APPROPRIATE TIME. A ROLL CALL VOTE WILL BE TAKEN FOR ALL 5 

ACTION ITEMS. THE CHAT FEATURE IS ACTIVE, HOWEVER, PLEASE BE 6 

AWARE THAT ANYTHING TYPED INTO THE CHAT WILL BE SUBJECT TO 7 

PUBLIC DISCLOSURE. THE CHAT FEATURE IS NOT AVAILABLE TO 8 

ATTENDEES. IN ORDER TO GET THE FULL ZOOM EXPERIENCE, PLEASE 9 

MAKE SURE YOUR APPLICATION IS UP TO DATE.  10 

 11 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. THANK YOU FOR THE 12 

NEW FEATURE. SO NEXT IS ROLL CALL.  13 

 14 

CLERK OF THE BOARD: YES. GOOD MORNING. BRUINS?  15 

 16 

JEANNIE BRUINS, VICE CHAIR: PRESENT.  17 

 18 

CLERK OF THE BOARD: DUTRA-VERNACI? IS PRESENT. I SEE.  19 

 20 

CAROL DUTRA-VERNACI: I WAS MUTED. I APOLOGIZE. I'M HERE.  21 

 22 

CLERK OF THE BOARD: GLOVER?  23 

 24 

FEDERAL D. GLOVER, CHAIR: HERE.  25 
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 1 

CLERK OF THE BOARD: JOSEFOWITZ IS ABSENT. PAPAN?  2 

 3 

GINA PAPAN: HERE.  4 

 5 

CLERK OF THE BOARD: RONEN IS ABSENT. SCHAFF IS ABSENT. AND 6 

TAVARES IS ABSENT. AND WORTH?  7 

 8 

AMY R. WORTH: HERE.  9 

 10 

CLERK OF THE BOARD: THANK YOU. QUORUM IS PRESENT.  11 

 12 

FEDERAL D. GLOVER, CHAIR: THANK YOU. CAN WE HAVE A SHOWING OF 13 

THE FLAG? AND WE WILL HAVE THE PLEDGE OF ALLEGIANCE.  14 

 15 

CLERK OF THE BOARD: I BELIEVE WE DO NOT HAVE A FLAG TO SHOW, 16 

HOWEVER --  17 

 18 

FEDERAL D. GLOVER, CHAIR: OKAY.  19 

 20 

AMY R. WORTH: FEDERAL, IT LOOKS LIKE GINA HAS GOT ONE.  21 

 22 

CAROL DUTRA-VERNACI: YEAH. GINA HAS GOT EVERYTHING, I'LL TELL 23 

YOU. [LAUGHTER]  24 

 25 
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FEDERAL D. GLOVER, CHAIR: ALL RIGHT.  1 

 2 

CLERK OF THE BOARD: OUTSTANDING.  3 

 4 

FEDERAL D. GLOVER, CHAIR: ALL RIGHT. IF YOU COULD SHOW YOUR 5 

FLAG?  6 

 7 

CLERK OF THE BOARD: WE CAN ALL SEE IT, BUT --  8 

 9 

FEDERAL D. GLOVER, CHAIR: OKAY. OKAY. THERE WE GO. THERE WE 10 

GO. ALL RIGHT. LET'S BEGIN. [ PLEDGE OF ALLEGIANCE ] "I PLEDGE 11 

ALLEGIANCE TO THE FLAG OF THE UNITED STATES OF AMERICA, AND TO 12 

THE REPUBLIC FOR WHICH IT STANDS, ONE NATION UNDER GOD, 13 

INDIVISIBLE, WITH LIBERTY AND JUSTICE FOR ALL."  14 

 15 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. WE'LL NOW MOVE TO 16 

OUR NEXT ORDER OF BUSINESS. AND IF I COULD HAVE THE READING OF 17 

THE COMPENSATION ANNOUNCEMENT.  18 

 19 

CLERK OF THE BOARD: OF COURSE. AS AUTHORIZED BY STATE LAW I AM 20 

MAKING THE FOLLOWING ANNOUNCEMENT. EACH MEMBER OF THE BOARD 21 

HERE TODAY WILL BE ENTITLED TO RECEIVE $100 PER MEETING 22 

ATTENDED UP TO A MAXIMUM OF $500 PER MONTH PER AGENCY. THIS 23 

AMOUNT IS A PROVIDED AS A RESULT OF CONVENING A MEETING FOR 24 

WHICH EACH MEMBER IS ENTITLED TO COLLECT SUCH AMOUNT.  25 
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 1 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. OUR NEXT ITEM WILL 2 

BE OUR CONSENT CALENDAR. WE HAVE THE CONSENT CALENDAR. ANY 3 

MEMBERS LOOKING TO PULL ANYTHING? ANY MEMBER OF THE PUBLIC 4 

POSED TO REMOVE ANYTHING FROM THE CONSENT?  5 

 6 

JEANNIE BRUINS, VICE CHAIR: CHAIR, I MOVE APPROVAL OF THE 7 

CONSENT CALENDAR. BRUINS.  8 

 9 

FEDERAL D. GLOVER, CHAIR: OKAY. BRUINS MOVED. IS THERE A 10 

SECOND?  11 

 12 

GINA PAPAN: PAPAN SECOND.  13 

 14 

FEDERAL D. GLOVER, CHAIR: PAPAN SECOND. OKAY. ALL IN FAVOR, 15 

ROLL CALL?  16 

 17 

CLERK OF THE BOARD: [ROLL CALL VOTE] THANK YOU. MOTION PASSES 18 

UNANIMOUSLY.  19 

 20 

FEDERAL D. GLOVER, CHAIR: THANK YOU. WE'LL MOVE RIGHT ALONG. 21 

OUR FIRST ACTION BEFORE US TODAY IS A CONTRACT, THE PLANNED 22 

BAY AREA 2050 ENVIRONMENTAL IMPACT REPORT. AND THIS WILL BE 23 

PRESENTED TO US BY CRAIG.  24 

 25 
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CHIRAG RABARI: THANK YOU CHAIR GLOVER AND GOOD MORNING 1 

COMMISSIONERS MY NAME IS CHIRAG RABARI WITH THE PLANNING 2 

PROGRAM. AND I'LL BE GIVING A BRIEF PRESENTATION ON THIS ITEM. 3 

TO AUTHORIZE EXECUTIVE DIRECTOR OR DESIGNEE TO ENTER INTO 4 

CONTRACT WITH A CENT ENVIRONMENTAL TO PROVIDE THE 5 

ENVIRONMENTAL IMPACT REPORT FOR PLANNED BAY AREA 2050. WITH 6 

LAST MONTH'S RELEASE OF THE DRAFT BLUEPRINT FOR PLANNED BAY 7 

AREA 2050 AND AS WE MOVE TOWARDS THE FINAL BLUEPRINT IT'S TIME 8 

TO GEAR UP FOR THE ENVIRONMENTAL ANALYSIS PHASE OF THE PLAN. 9 

PREPARATION OF THE EIR IS REQUIRED UNDER CEQA AS WELL AS OTHER 10 

APPLICABLE PROVISIONS OF FEDERAL AND STATE LAW INCLUDING FAST 11 

ACT AND SB 375, AND THE PURPOSE OF EIR IS TO INFORM THE PUBLIC 12 

OF THE POTENTIAL ENVIRONMENTAL IMPACTS OF IMPLEMENTING THE 13 

TRANSPORTATION, HOUSING, ECONOMIC, AND ENVIRONMENTAL 14 

STRATEGIES IN THE PLAN. EIR MUST ALSO IDENTIFY FEASIBLE 15 

MITIGATION MEASURES AND EVALUATE A RANGE OF PLAN ALTERNATIVES 16 

TO MINIMIZE ANY SIGNIFICANT ADVERSE IMPACTS THAT ARE 17 

IDENTIFIED. IN ORDER TO OBTAIN THE TECHNICAL SUPPORT AND 18 

EXPERTISE NECESSARY TO CONDUCT THIS ENVIRONMENTAL ANALYSIS ON 19 

MAY 28TH MTC ISSUED A REQUEST FOR PROPOSALS WHICH WAS SENT TO 20 

NEARLY 3,000 FIRMS. RFP TERMS WERE DOWNLOADED FROM OUR 21 

PROCUREMENT PORTAL BY 70 FIRMS AND IN JUNE WE ATTENDED A 22 

CONFERENCE OF SEVEN FIRMS WE RECEIVED TWO PROPOSALS BY THE 23 

DEADLINE BASED ON EVALUATION CRITERIA DEVELOPED FOR THE RFP 24 

THE PANEL REVIEWING THE PROPOSALS RECOMMENDS THE TEAM LED BY 25 
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ASSENT ENVIRONMENTAL. TEAMS ATTRIBUTE THE QUALIFICATION IN THE 1 

RFP MADE SUPPORTIVE CLAIMS AND MET OR EXCEEDED EVALUATIONS IN 2 

ALL AREAS. ASSENT HAS A HIGHLY QUALIFIED TEAM WITH EXPERIENCE 3 

CONDUCTING EIRS ARE OF SIMILAR SIZE AND SCOPE SIGNIFICANT 4 

KNOWLEDGE OF KEY PLANNING AND ENVIRONMENTAL ISSUES IN THE BAY 5 

AREA, A CLEAR UNDERSTANDING OF HOW CHANGES TO THE PLAN'S 6 

GROWTH FRAMEWORK, YOU KNOW, THE ADDITION OF NEW GEOGRAPHIES 7 

MAY IMPACT EIR AND APPROACH TO THE PROJECT THAT ANTICIPATED 8 

AND PROPOSED PROACTIVE SOLUTIONS TO POTENTIAL CHALLENGE AREAS. 9 

FUNDS TO SUPPORT THIS CONTRACT ARE IN THE APPROVED FY '2021 10 

AGENCY BUDGET. AND IF APPROVED BY THE COMMITTEE, AND A 11 

CONTRACT WERE TO BE EXECUTED, WE EXPECT WORK TO BEGIN LATER 12 

THIS MONTH AND COMPLETE BY SEPTEMBER 2021 FOLLOWING ADOPTION 13 

OF THE FINAL PLANNED BAY AREA 2050. SO AGAIN, OUR 14 

RECOMMENDATION IS THAT THE COMMITTEE AUTHORIZE EXECUTIVE 15 

DIRECTOR DESIGNEE TO NEGOTIATE INTO CONTRACT WITH ASSENT 16 

ENVIRONMENTAL IN AN AMOUNT NOT TO EXCEED $397,373.52 TO 17 

PREPARE THE EIR FOR PLANNED BAY AREA 2050. AND THAT'S THE 18 

CLOSE OF MY PRESENTATION, AND I'M HAPPY TO TAKE ANY QUESTIONS.  19 

 20 

FEDERAL D. GLOVER, CHAIR: THANK YOU MR. RABARI. ANY QUESTIONS 21 

FROM THE COMMITTEE?  22 

 23 
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JEANNIE BRUINS, VICE CHAIR: I HAVE ONE QUESTION. DO WE HAVE AN 1 

IDEA WHY, AFTER HAVING SO MANY PEOPLE POLLED, AND LOOKED INTO 2 

THIS, WHY WE GOT DOWN TO TWO ACTUAL PROPOSERS?  3 

 4 

SPEAKER: THANK YOU COMMISSIONER BRUINS. THAT'S AN EXCELLENT 5 

QUESTION. AND I THINK I WOULD BE HAPPY FOR US TO FOLLOW UP AND 6 

MAYBE DO A LITTLE BIT MORE DIGGING ON WHY FIRMS ULTIMATELY, 7 

YOU KNOW, DID MAKE THAT DETERMINATION. I WOULD JUST OFFER THAT 8 

WE WERE HAPPY TO RECEIVE THE TWO PROPOSALS THAT WE RECEIVED 9 

WERE STRONG PROPOSALS AND ON SIMILAR PRICE SO THAT WAS AN 10 

OPTION.  11 

 12 

JEANNIE BRUINS, VICE CHAIR: I'M NOT CONCERNED ABOUT MOVING 13 

FORWARD AND I'M ACTUALLY HAPPY TO MAKE THE MOTION TO MOVE US 14 

FORWARD I'M JUST CURIOUS AS WE'RE STILL TRYING TO NAVIGATE 15 

COVID-19 AND TRYING TO UNDERSTAND IMPACTS AND LEARN FROM ALL 16 

OF THIS, IT'S PROBABLY MORE OUT OF CURIOSITY THAN ANYTHING 17 

ELSE. BUT I WOULD BE HAPPY TO MAKE THE MOTION WHEN, CHAIR, 18 

YOU'RE READY FOR A MOTION.  19 

 20 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. DO WE HAVE ANY 21 

PUBLIC COMMENTS ON THIS ITEM?  22 

 23 

CLERK OF THE BOARD: I SEE NO RAISED HANDS AND I HAVE RECEIVED 24 

NO WRITTEN PUBLIC COMMENT FOR THIS ITEM.  25 
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 1 

FEDERAL D. GLOVER, CHAIR: OKAY THANK YOU. VICE CHAIR BRUINS, 2 

IF YOU WOULD LIKE TO PROCEED WITH YOUR MOTION.  3 

 4 

JEANNIE BRUINS, VICE CHAIR: YES. I MOVE THE APPROVAL OF THE 5 

CONTRACT AS PRESENTED.  6 

 7 

AMY R. WORTH: I'LL SECOND THAT MOTION.  8 

 9 

FEDERAL D. GLOVER, CHAIR: MOVED BY BRUINS, SECOND BY WORTH, 10 

ALL IN FAVOR? ROLL CALL.  11 

 12 

CLERK OF THE BOARD: ROLL CALL. YES. [ROLL CALL VOTE] THANK 13 

YOU. MOTION PASSES UNANIMOUSLY.  14 

 15 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. NEXT ITEM ON THE 16 

AGENDA IS A RESOLUTION NUMBER 1058 REVISED, COMMISSION 17 

PROCEDURE MANUAL UPDATE. I HAVE HEARD FROM OUR EXECUTIVE 18 

DIRECTOR THAT THERE'S SOME ISSUES WITH THIS ITEM. AND WE WOULD 19 

LIKE FOR HER TO SHARE. THERESE.  20 

 21 

THERESE MCMILLAN: THANK YOU SO MUCH CHAIR GLOVER. GOOD MORNING 22 

COMMISSIONERS. AND I WOULD LIKE TO SPEAK ON 1058 REVISED. AS 23 

YOU ARE WELL AWARE, WE HAVE BEEN WORKING VERY DILIGENTLY TO 24 

PULL TOGETHER A MAJOR RECOMMENDATION FROM OUR GOVERNANCE 25 
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COMMITTEE, WHICH IS THE ESTABLISHMENT OF A CONSOLIDATED 1 

LEGISLATION COMMITTEE BETWEEN THE -- [ SILENCE ] -- 2 

LEGISLATIVE STANDING COMMITTEE, AND ABAG STANDING COMMITTEE. 3 

I'M GOING TO CHECK. CAN YOU ALL STILL HEAR ME? I HAVE BEEN 4 

HAVING MAJOR INTERNET CHALLENGES.  5 

 6 

FEDERAL D. GLOVER, CHAIR: WE CAN HEAR YOU CLEARLY NOW. YOU DID 7 

TAP OUT FOR A SECOND THERE.  8 

 9 

THERESE MCMILLAN: OKAY. SO, HOPEFULLY, I CAN CONTINUE TO MAKE 10 

THE PRESENTATION ON THIS ITEM. SO LET ME BE QUICK. GOVERNANCE 11 

COMMITTEE DID MAKE RECOMMENDATIONS FOR US TO RESOLVE SOME 12 

SPECIFIC ISSUES, WITH RESPECT TO PULLING A CONSOLIDATED 13 

COMMITTEE TOGETHER, A REFINED SET OF RECOMMENDATIONS WERE 14 

FORWARDED FROM THE GOVERNANCE COMMITTEE FOR CONSIDERATION BY 15 

MTC AND ABAG FROM THEIR JULY 22ND MEETING. I'M GOING TO TOUCH 16 

ON THE FIVE ISSUES -- OR SIX ISSUES THAT WERE OUTLINED 17 

BRIEFLY. AND ONE, WITH RESPECT TO MEMBERSHIP, IS THE AREA 18 

WHERE WE HAVE RECENTLY DISCOVERED THERE IS STILL A BIT MORE 19 

WORK TO DO. SO THE FIRST POINT WAS RESOLVING PROCEDURES AND 20 

QUESTIONS RELATED TO HOW THE CONSOLIDATED, JOINT, MTC ABAG 21 

LEGISLATION COMMITTEE WOULD REPORT DECISIONS UP TO THE TWO 22 

GOVERNING BOARDS. WHILE WE WILL HAVE A CONSOLIDATED COMMITTEE, 23 

RECOMMENDATIONS FROM THIS COMMITTEE WILL BE ADVANCED 24 

SEPARATELY TO MTC COMMISSION, AND TO THE ABAG EXECUTIVE BOARD 25 
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FOR THEM TO TAKE SPECIFIC FINAL ACTIONS INDEPENDENTLY. SO, WE 1 

JUST WANTED TO CLARIFY THAT THAT'S A SPECIFIC WAY THAT THAT 2 

DECISION PROCESS IS GOING TO HAPPEN. THE SECOND POINT, FOR 3 

CLARIFICATION, WOULD BE HOW THE LEGISLATION -- THE 4 

CONSOLIDATED LEGISLATION COMMITTEE, WOULD ADDRESS, ON SHORT 5 

NOTICE, ISSUES -- LEGISLATIVE ISSUES, WHEN THE GOVERNING 6 

BOARD'S CALENDARS WOULDN'T ALLOW TIME FOR THEM TO TAKE THOSE 7 

ACTIONS. AS YOU KNOW, VERY OFTEN IN SACRAMENTO AND TO SEE 8 

THINGS ARE MOVING SWIFTLY, BOTH COMMITTEES DID HAVE PROVISIONS 9 

TO ALLOW FOR TIMELY ACTIONS IN BETWEEN URGENCY PROVISIONS, 10 

THOSE SAME THINGS WILL CARRY OVER TO THE [ SILENCE ]  11 

 12 

FEDERAL D. GLOVER, CHAIR: YOU'RE TAPPING OUT.  13 

 14 

THERESE MCMILLAN: I'M SORRY.  15 

 16 

FEDERAL D. GLOVER, CHAIR: SO YOU WERE SAYING --  17 

 18 

THERESE MCMILLAN: CAN YOU HEAR ME NOW?  19 

 20 

FEDERAL D. GLOVER, CHAIR: YES.  21 

 22 

THERESE MCMILLAN: OKAY. I'M JUST REITERATING THE POINTS IN THE 23 

MEMO. THE THIRD POINT HAS TO DO WITH HOW WILL THE CONSOLIDATED 24 

COMMITTEE ACT ON BILLS OF INTEREST THAT MIGHT BE SPECIFIC TO 25 
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MTC, OR TO ABAG. IN THOSE CIRCUMSTANCES, WHAT WE ARE 1 

RECOMMENDING HERE, IS THAT THIS CONSOLIDATED COMMITTEE WILL 2 

TAKE UP ALL BILLS THAT COME BEFORE IT. BUT IF INDIVIDUAL 3 

MEMBERS FROM MTC OR ABAG BELIEVE THAT THEY DON'T HAVE THE 4 

EXPERTISE OR INTEREST IN ORDER TO VOTE THOUGHTFULLY, THEY CAN 5 

ABSTAIN, AND THAT WOULD BE A WAY TO ALLOW FOR THOSE 6 

DISTINCTIONS TO BE MADE. A FIFTH ISSUE WAS HOW WILL BE CHAIR 7 

AND VICE CHAIR OF THE CONSOLIDATED LEGISLATION COMMITTEE BE 8 

SELECTED. IN SHORT, THE COMMITTEE, AT ITS FIRST MEETING, WILL 9 

VOTE IN A CHAIR FROM MTC OR ABAG, AND THE VICE CHAIR WOULD BE 10 

FROM THE OTHER COMMITTEES, SO THEY WILL, YOU KNOW, IT WILL 11 

ALTERNATE, CHAIR, VICE CHAIR, BETWEEN MTC AND ABAG, AND THAT 12 

ROTATION WILL HAPPEN EVERY TWO YEARS. THE SIXTH ISSUE HAS TO 13 

DO WITH RECONCILING AN OPEN VERSUS CLOSED MEMBERSHIP, AND HOW 14 

TO MAINTAIN QUORUM. THIS WAS A TOPIC OF CONSIDERABLE 15 

DISCUSSION, BUT IT WAS RESOLVED IN THIS WAY. THAT, MTC 16 

COMMISSIONERS, AS IS THE CURRENT PRACTICE, THAT ARE NOT 17 

APPOINTED TO A PARTICULAR COMMITTEE, CAN ATTEND AN AD-HOC, 18 

NON-VOTING MEMBERS, UNDER CURRENT PROCEDURES, THAT PROCESS 19 

WILL ALSO BE EXTENDED TO THE ABAG BOARD FOR PURPOSES OF THE 20 

LEGISLATION COMMITTEE. ANY MTC COMMISSIONER OR ANY ABAG 21 

EXECUTIVE BOARD MEMBER HAS THE OPPORTUNITY TO PARTICIPATE AS A 22 

NON-VOTING MEMBER FOR THIS CONSOLIDATED LEGISLATION COMMITTEE. 23 

FURTHERMORE, SHOULD THERE BE QUORUM ISSUES FOR THE LEGISLATION 24 

CONSOLIDATED COMMITTEE, MTC OR EXECUTIVE BOARD MEMBERS CAN BE 25 
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DEPUTIZED TO ADDRESS THOSE QUORUM ISSUES. SO THAT'S HOW WE 1 

HAVE ADDRESSED THAT SITUATION. LET ME NOW TURN TO THE QUESTION 2 

OF MEMBERSHIP. BECAUSE THIS IS THE ARENA WHERE SOME FURTHER 3 

ADJUSTMENTS NEED TO BE MADE. OVERALL, CHAIR HAGGERTY, AND 4 

PRESIDENT ARREGUIN WILL BE MEETING TO DISCUSS APPOINTMENTS TO 5 

THE COMMITTEE BEFORE FORMALIZING THEIR RECOMMENDATIONS. WITH 6 

AN EMPHASIS ON STRIKING APPROPRIATE BALANCE BETWEEN COUNTY 7 

REPRESENTATION, JURISDICTIONAL SIZE, ET CETERA. A KEY 8 

OBJECTIVE HERE, IS THAT THERE WILL BE EQUAL NUMBERS OF MTC 9 

REPRESENTATIVES, AND ABAG REPRESENTATIVES ON THIS CONSOLIDATED 10 

COMMITTEE. HOWEVER, THE ISSUE THAT AROSE VERY RECENTLY HAS TO 11 

DO WITH THE FACT THAT THE COMMISSION PROCEDURES MANUAL AND THE 12 

ABAG BYLAWS ARE NOT ALIGNED WITH RESPECT TO THE ROLE ON 13 

COMMITTEES OF THE CHAIR AND VICE CHAIR OF MTC, AND THE 14 

PRESIDENT AND VICE PRESIDENT OF ABAG. THOSE TWO ESTABLISHING 15 

DOCUMENTS ARE A BIT IN CONFLICT WITH RESPECT TO THOSE RULES. 16 

THE OBJECTIVE IS TO HAVE EQUIVALENT STATUS FOR THE CHAIR AND 17 

VICE CHAIR OF MTC, AND THE PRESIDENT AND VICE PRESIDENT OF 18 

ABAG ON THIS CONSOLIDATED LEGISLATIVE COMMITTEE. WE THOUGHT WE 19 

HAD IT FIXED. WE ARE NOT QUITE THERE. SO, WHAT WE WILL BE 20 

ASKING IS FOR THIS ADMINISTRATION COMMITTEE TO RECOMMEND THE 21 

CHANGES, NOTING THAT FURTHER ADJUSTMENTS WILL NEED TO BE MADE 22 

IN ORDER TO ENSURE THIS OUTCOME IS ACHIEVED. SO, THAT JUST -- 23 

WITHOUT GOING INTO THE WEEDS, THIS'S THE ISSUE THAT STILL 24 

NEEDS TO BE RESOLVED. IN ADDITION THAT, WITH RESPECT TO 25 
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MEMBERSHIP, THIS IS ANOTHER SITUATION WHERE, AGAIN, THE 1 

COMMISSION PROCEDURES MANUAL, AND ABAG BYLAWS AREN'T QUITE 2 

ALIGNED, WE NEED TO CLARIFY THE ROLE OF EX-OFFICIO NON-VOTING 3 

MEMBERS SERVING AS OFFICIAL MEMBERS THIS CONSOLIDATED 4 

COMMITTEE. THERE IS DIFFERENCES IN HOW ABAG AND MTC HAVE 5 

ADJUSTED AND DEALT WITH THAT, AND WE NEED TO WORK WITH THE 6 

PRESIDENT, JESSE ARREQUIN OF ABAG, AND CHAIR SCOTT HAGGERTY OF 7 

MTC IN ORDER TO GET TO AN AGREEMENT ON HOW THAT SPECIFICALLY 8 

SHOULD WORK. DEEP APOLOGIES, WE THOUGHT WE HAD ALL THESE 9 

THINGS DOWN BUT REALIZED GOING INTO THE MEETING TODAY, THESE 10 

ARE AREA THAT STILL AREN'T QUITE ALIGNED. THERE ARE OPTIONS TO 11 

MAKE THAT HAPPEN, AND WE WILL BE DISCUSSING THAT WITH THE 12 

CHAIR AND VICE CHAIR, AND PRESIDENT AND VICE PERSPECTIVE OF 13 

MTC AND ABAG. BUT WE WANT TO GET IT RIGHT, AND WE DIDN'T WANT 14 

TO DO IT ON THE FLY WITH YOU THIS MORNING. SO WITH THAT, I 15 

WOULD -- STAFF RECOMMENDS THAT THE ADMINISTRATION COMMITTEE 16 

FORWARD RESOLUTION 1053, REVISED, NOTING THAT THERE ARE STILL 17 

SOME ADJUSTMENTS THAT NEED TO BE MADE ON THE ISSUE I 18 

DESCRIBED, WITH RESPECT TO RULES OF THE CHAIR AND VICE CHAIR 19 

AS MEMBERS OF THIS NEW CONSOLIDATED COMMITTEE. I'M HAPPY TO 20 

ANSWER ANY QUESTIONS. OUR GENERAL COUNSEL ADRIENNE WEIL IS 21 

ALSO AVAILABLE IF YOU HAVE SOME SPECIFICS ON THE ISSUES I 22 

RAISED. THANK YOU.  23 

 24 

JEANNIE BRUINS, VICE CHAIR: CHAIR GLOVER, YOU ARE MUTED.  25 
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 1 

CLERK OF THE BOARD: THANK YOU. YOU REMUTED YOURSELF. [ SILENCE 2 

]  3 

 4 

FEDERAL D. GLOVER, CHAIR: CAN YOU HEAR ME NOW?  5 

 6 

JEANNIE BRUINS, VICE CHAIR: YES.  7 

 8 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. IS THERE ANY 9 

COMMENT FROM BOARD MEMBERS?  10 

 11 

JEANNIE BRUINS, VICE CHAIR: YES, I DO.  12 

 13 

FEDERAL D. GLOVER, CHAIR: OKAY.  14 

 15 

JEANNIE BRUINS, VICE CHAIR: JEANNIE BRUINS HERE. I HAVE A 16 

COUPLE OF QUESTIONS. SO, AT A TACTICAL LEVEL, I'M TRYING TO 17 

UNDERSTAND, HOW IS IT THAT WE CAN HAVE A COMMITTEE THAT 18 

CONSISTS OF A MAJORITY OF OUR MTC COMMISSIONERS? SO I'M 19 

WONDERING, IN TERMS FROM A BROWN ACT POINT OF VIEW, ALL OF OUR 20 

COMMITTEES, OUR STANDING COMMITTEES ET CETERA HAVE ALWAYS BEEN 21 

EIGHT COMMISSIONERS ON THEM, YET THIS IS NOW A PROPOSAL THAT 22 

HAS 11 COMMISSIONERS AND WE'RE 11 OUT OF 18. SO IS THAT A 23 

BROWN ACT ISSUE? THAT'S MY FIRST QUESTION.  24 

 25 
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ADRIENNE WEIL, COUNSEL: I DON'T BELIEVE SO, COMMISSIONER 1 

BRUINS. I MEAN, IT WOULD HAVE -- IT'S A BROWN -- IT WOULD HAVE 2 

TO BE NOTICED AS A BROWN MEETING.  3 

 4 

JEANNIE BRUINS, VICE CHAIR: YEAH I -- STOP IT. NO. NO. NO. NO.  5 

 6 

AMY R. WORTH: HE WANTS TO BE ON THE COMMITTEE JEANNE.  7 

 8 

JEANNIE BRUINS, VICE CHAIR: I KNOW. IT'S A MATTER OF USUALLY 9 

YOUR COMMITTEES CANNOT BE A MAJORITY OF A BODY, OF A GOVERNING 10 

BODY. SO IN ALL THE -- MY INTERPRETATIONS OF THE BROWN ACT YOU 11 

WOULD NOT HAVE A COMMITTEE THAT'S GREATER THAN THE MAJORITY OF 12 

A BODY BECAUSE IT'S IN A PUBLIC SETTING BY NATURE OF TWO 13 

BODIES COMING TOGETHER THAT AUTOMATICALLY MAKES IT A BROWN ACT 14 

NOTICED MEETING BUT IN TERMS OF PARTICIPATION, I GUESS I WOULD 15 

LIKE TO ADD TO THE LIST OF THINGS TO BE LOOKED AT NOW AND 16 

GOING TO THE COMMISSION AS TO WHETHER OR NOT YOU CAN PUTS 17 

LEGALLY 11 MEMBERS OF OUR BODY ON THIS OR WHETHER WE NEED TO 18 

STAY WITH EIGHT MEMBERS OF OUR BODY. NEXT QUESTION I HAVE, IS 19 

WHEN WE FIRST DISCUSSED DOING THIS, IT SEEMED TO ME AT THAT 20 

POINT IN TIME THAT IT WAS A NO-BRAINER BECAUSE WE HAD THESE 21 

TWO COMMITTEES WORKING KIND OF COLLABORATIVELY TOGETHER ET 22 

CETERA, BUT NOW THAT WE HAVE IT IN WRITING, I HAVE TO SAY, I'M 23 

NOT CLEAR WHAT PROBLEM WE'RE SOLVING BY ACTUALLY DOING AN 24 

OFFICIAL CONSOLIDATION VERSUS WHAT NEW PROBLEMS ARE WE 25 
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CREATING. AND SO, MAYBE IF WE COULD START AND BACK UP, AND 1 

HELP ME UNDERSTAND, HOW DOES THIS, EITHER WHAT PROBLEM ARE WE 2 

SOLVING, OR WHAT OPPORTUNITY ARE WE CAPTURING THAT WOULD 3 

WARRANT US ACTUALLY PUTTING THESE TWO BODIES TOGETHER VERSUS 4 

CONTINUING TO OPERATE IN THE FASHION THAT WE HAVE BEEN 5 

OPERATING?  6 

 7 

THERESE MCMILLAN: WHEN WE WERE -- THIS IS THERESE MCMILLAN 8 

EXECUTIVE DIRECTOR, AGAIN, I HOPE THAT YOU CAN HEAR ME OKAY. 9 

THE -- WHEN -- MAYBE ALSO WE POLL THAT TO THE GOVERNANCE 10 

QUESTION, GENERALLY, IT HAD BEEN, I THINK, CERTAINLY, DECIDED 11 

THAT WE WANTED TO MAXIMIZE THE OPPORTUNITIES FOR TRULY 12 

COLLABORATIVE CONSIDERATION AND DISCUSSION OF ISSUES, THAT 13 

SHORT OF COMBINING BOTH BOARDS -- AND I THINK THAT WAS AN 14 

EARLY, YOU KNOW, DECISION THAT GROUPS WERE NOT READY FOR THAT 15 

-- BUT WE WANTED TO CREATE OPPORTUNITIES AT A SMALLER SCALE, 16 

AND WE IDENTIFIED THE LEGISLATION COMMITTEE, AND THE PLANNING 17 

AND ADMINISTRATION COMMITTEES THAT JOINT MEETING, THAT IS 18 

ESTABLISHED -- [ SILENCE ] OFTEN TOGETHER. TO --  19 

 20 

FEDERAL D. GLOVER, CHAIR: SO THERESE, YOU HAD CUT OUT THERE 21 

FOR A WHILE.  22 

 23 

THERESE MCMILLAN: OH I'M SORRY. AM I BACK?  24 

 25 
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FEDERAL D. GLOVER, CHAIR: YOU'RE BACK.  1 

 2 

THERESE MCMILLAN: THE POINT WAS THAT, SHORT OF CONSOLIDATING 3 

BOTH BOARDS IN ITS ENTIRETY, WE WANTED TO CREATE A FORUM -- 4 

CREATED A SINGLE DECISION MAKING BODY ON ISSUES OF IMPORT 5 

BETWEEN MTC AND ABAG. AND THAT'S A LEGISLATION COMMITTEE, AND 6 

ITS PORTFOLIO, BUT THE TWO LEGISLATION COMMITTEES, AND THEIR 7 

PORTFOLIOS, AS WELL AS THE PLANNING AND -- MTC PLANNING 8 

COMMITTEE, AND THE ABAG ADMINISTRATION COMMITTEE, WHICH HAS 9 

BEEN MEETING JOINTLY ON BROADER PLANNING AND RELATED POLICY 10 

ISSUES, WHERE THE TWO PLACES WHERE DELIBERATELY FORMING ONE 11 

BODY TO ADVANCE, WE HOPE, A MORE COLLABORATIVE ENVIRONMENT NOT 12 

ONLY ON THE ISSUES THEMSELVES, BUT ON THE RESOURCES AND OTHER 13 

SUPPORTING ELEMENTS NEEDED VERY OFTEN TO IMPLEMENT 14 

RECOMMENDATIONS COMING OUT OF THESE BODIES COULD BE 15 

ESTABLISHED, AGAIN, IN A SINGLE BODY.  16 

 17 

DIR. SCOTT HAGGERTY: THERESE, CAN I JUST SAY SOMETHING? I 18 

THINK IT'S ALSO IMPORTANT TO NOTE THAT THIS IS A JUMPING OFF 19 

POINT. THIS IS THE FIRST COMMITTEE THAT WE'RE LOOKING AT 20 

MERGING. THERE WILL BE OTHER COMMITTEES, BUT WE DECIDED THAT 21 

WE WOULD KIND OF TAKE IT ONE AT A TIME. SO, THIS ISN'T THE 22 

END-POINT, AND WHAT THIS DOES IS ACTUALLY GETS US TO A POINT 23 

WHERE FIRST OF ALL IT'S EASIER ON STAFF HAVING THESE MERGED 24 

COMMITTEES BUT ALSO IT MAKES US LOOK A LITTLE BIT MORE 25 
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FUNCTIONAL THAN HAVING ALL THESE COMMITTEE MEETINGS AND ABAG 1 

HAS HAD A TREMENDOUS AMOUNT OF COMMITTEE MEETINGS AS OF LATE, 2 

BUT I THINK IT GETS US TO A POINT WHERE WE'RE FUNCTIONALLY 3 

INTEGRATED AND THAT'S THE GOAL. GOAL IS GETTING TO INTEGRATED 4 

SPEAKING WITH ONE VOICE AND DOING WHAT'S BEST FOR THE BAY AREA 5 

I THINK THAT'S WHAT WE'RE TRYING TO GET TO.  6 

 7 

THERESE MCMILLAN: SO AND I -- AND THE ONLY THING I WOULD ADD, 8 

IS I JUST WANTED TO MAKE THE POINT THAT THE, YOU KNOW, OF THE 9 

TECHNICALITIES OF IT BEING PUT TOGETHER SHOULD NOT OVERSHADOW 10 

THE BROADER OBJECTIVE, THAT THE COLLABORATIVE SPACE THAT CHAIR 11 

HAGGERTY JUST SPOKE TO, AND SO I JUST WANTED TO NOTE THAT 12 

IT'S, UNFORTUNATELY, I HAD TO FOCUS ON THOSE TECHNICALITIES OF 13 

GETTING IT THROUGH, BUT THAT IS NOT, YOU KNOW, IN ANY WAY 14 

SHOULD NOT OVERSHADOW THE LARGER OBJECTIVE. JUST WANTED TO ADD 15 

THAT. THANKS.  16 

 17 

JEANNIE BRUINS, VICE CHAIR: OKAY. SO FOR ME, AGAIN, THE FIRST 18 

CONCERN IS WHETHER OR NOT WE ARE COMPLIANT IF WE HAVE A 19 

MAJORITY OF OUR COMMISSION ON A COMMITTEE, AND I THINK THAT 20 

WOULD CARRY FORWARD WITH ANY OTHER CONSOLIDATIONS THAT WE'RE 21 

TALKING ABOUT. OTHER THING IS, AGAIN, I APPRECIATE TRYING TO 22 

GET MORE EFFICIENT AND SUCH, BUT IF WE HAVE -- IF THIS BODY 23 

HAS TO OPERATE WITH A QUORUM LIKE ALL THE REST OF OUR 24 

COMMITTEES DO, AND SO, IF -- JUST GO TO A WORST-CASE SCENARIO, 25 
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IF YOU ONLY HAD A MAJORITY OF THE PEOPLE THERE, WERE FROM ONE 1 

BODY VERSUS THE OTHER BODY, AND THEN WHAT'S ON THE AGENDA IS 2 

DEALING WITH SUBJECT MATTER THAT IS RELEVANT TO THE BODY THAT 3 

HAS A MAJORITY OF THE -- THE MINORITY OF THE PEOPLE PRESENT AT 4 

IT. YOU KNOW, IF THERE'S SOMETHING ABOUT ABAG, OKAY, THAT IT'S 5 

LEGISLATION, OR SOMETHING THAT'S PERTINENT TO THEM, AND NOT SO 6 

MUCH TO MTC IT CLEARLY SAYS THAT AS AN MTC COMMISSIONER, THE 7 

COMMISSIONER COULD CHOOSE TO ABSTAIN. BUT AT SOME POINT, IF 8 

ALL OF THE MTC PEOPLE, YOU KNOW, ABSTAIN, AND YOU DON'T HAVE -9 

- I MEAN, HOW DO YOU DO THE VOTING? HOW DO YOU GET TO WHO IS 10 

VOTING TO DO WHAT'S IN THE BEST INTEREST OF ABAG GOVERNING 11 

BODY, WHEN YOU MIGHT NOT -- WHEN YOU MIGHT BE 12 

DISPROPORTIONATELY WITH MTC PEOPLE WEIGHING IN WHICH IS NOT 13 

NECESSARILY THE EXPERTISE. I'M JUST TRYING TO FIGURE OUT HOW 14 

ALL THAT VOTING THING WORKS AND MAYBE MORE ON THAT. IT SEEMS 15 

LIKE IT'S GETTING NEEDLESSLY COMPLICATED WHEREAS TODAY YOU 16 

HAVE A BRIGHTER LINE BETWEEN THAT. SO YEAH, PULLING TOGETHER, 17 

AND WHEN YOU HAVE COMMITTEES, IF YOU'RE COMMITTEES IS MADE UP 18 

OF PEOPLE WHO SERVE ON BOTH BODIES THAT MAKES A LOT MORE SENSE 19 

AND YOU CAN SEE THE EFFICIENCIES THERE BUT I DIDN'T SEE THAT 20 

AS BEING ONE OF THE REQUIREMENT IN HOW WE'RE APPOINTING 21 

PEOPLE. SO I THINK -- AND I DON'T KNOW -- MAYBE MY LAST 22 

QUESTION IS, HOW MUCH STUFF THAT COMES THROUGH THE LEGISLATIVE 23 

BODIES REALLY IS PERTINENT TO BOTH ABAG AND MTC? IS THAT 24 
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CLEARLY A VAST MAJORITY OF THE WORK THAT IS DONE BY THE 1 

COMMITTEES TODAY?  2 

 3 

THERESE MCMILLAN: I WOULD SAY THAT INCREASINGLY AGAIN -- 4 

THERESE MCMILLAN, EXECUTIVE DIRECTOR -- INCREASINGLY, AGAIN, 5 

WE HAVE SEEN THAT THE ISSUES THAT ARE, FOR EXAMPLE, DEALING 6 

WITH CLIMATE CHANGE ISSUES THAT ARE DEALING WITH HOUSING, 7 

ISSUES THAT ARE DEALING WITH THE FUNDING AVAILABLE FOR PUBLIC 8 

TRANSIT, GIVEN THIS OUR LONG RANGE PLAN, PLANNED BAY AREA 2050 9 

POINTS OUT THE INTERRELATED NATURE OF ALL OF THESE ISSUES, AND 10 

IF THOSE AREAS FUNCTIONALLY ARE NOT WORKING TOGETHER TO 11 

ADVANCE, YOU KNOW, AN OPPORTUNITY FOR BAY AREA RESIDENTS, THAT 12 

THEN COLLECTIVELY WE'RE FOLLOWING. AND I WOULD POINT OUT THAT 13 

OTHER MPOS DEAL WITH ALL OF THESE ISSUES TOGETHER, WHERE THOSE 14 

BOARDS ARE, YOU KNOW, DEALING WITH THESE ISSUES, THEY'RE SET 15 

UP TO DEAL WITH THEM COLLECTIVELY. SO IN FACT, WE ARE DOING 16 

THE SAME THING BY VIRTUE OF BRINGING THESE TOGETHER IN THIS 17 

FORUM.  18 

 19 

JEANNIE BRUINS, VICE CHAIR: THANK YOU.  20 

 21 

FEDERAL D. GLOVER, CHAIR: OKAY. ARE THERE ANY OTHER QUESTIONS?  22 

 23 

JAKE MACKENZIE: I HAVE MY HAND RAISED, CHAIR GLOVER.  24 

 25 
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FEDERAL D. GLOVER, CHAIR: WELL, WE ARE ACKNOWLEDGING THAT HAND 1 

RAISE. GO AHEAD. COMMISSIONER.  2 

 3 

JAKE MACKENZIE: THANK YOU. I AM FASCINATED BY THIS DISCUSSION 4 

AS THE CURRENT CHAIR OF MTC'S LEGISLATION COMMITTEE, WHICH HAS 5 

BEEN MEETING JOINTLY WITH ABAG'S LEGISLATION COMMITTEE UNDER 6 

THE CHAIR OF JULIE PIERCE. WE HAVE ACTUALLY BEEN DOING THIS 7 

SINCE WE AGREED TO SIGN THE CASA COMPACT, AND THE CREATION OF 8 

A SPECIAL MECHANISM AT THAT TIME, AND WE HAVE BEEN MEETING 9 

JOINTLY, AND I WOULD ARGUE SUCCESSFULLY, OVER THE PAST YEAR 10 

AND A HALF. WHAT I JUST HEARD WAS THAT, YOU KNOW, A VERY 11 

STRONG ARGUMENT FOR, ACTUALLY MOVING TOWARDS ONE GOVERNING 12 

BOARD. AND I HEAR OUR CHAIR SAYING, WELL, THIS IS A FIRST 13 

STEP, AND I WOULD ACKNOWLEDGE THAT. SO THAT BEING THE CASE, 14 

THE PRESENT MECHANISM AS FOR AS I'M CONCERNED, CONTINUES TO 15 

WORK WELL AND COOPERATIVELY BETWEEN THE TWO AGENCIES, AND MY 16 

OBSERVATION IS THAT IT'S BEEN STAFFED, BOTH THESE COMMITTEES 17 

HAVE BEEN STAFFED BY THE SAME PEOPLE AT THE SAME TIME. THAT 18 

BEING SAID, I DO HAVE A QUESTION. EVER SINCE I HAVE BEEN ON 19 

THE COMMISSION, IT WAS TOLD TO ME THAT WE HAVE WEDNESDAY 20 

COMMITTEES, AND WE HAVE FRIDAY COMMITTEES. SO IF YOU'RE ON THE 21 

FRIDAY COMMITTEES, THEN, IPSO DE FACTO, THEN YOU ARE A MEMBER 22 

OF THE LEGISLATION COMMITTEE. AND DOES THAT CONTINUE TO BE THE 23 

CASE IF THIS COMBINATION IS ADOPTED?  24 

 25 
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THERESE MCMILLAN: I DEFER TO CHAIR HAGGERTY TO ADDRESS THAT AS 1 

HE AND PRESIDENT ARREGUIN HAVE BEEN DISCUSSING WITH HOW TO 2 

MOVE FORWARD WITH APPOINTMENTS TO THE COMMITTEE.  3 

 4 

FEDERAL D. GLOVER, CHAIR: ARE YOU STILL ON? CHAIR HAGGERTY?  5 

 6 

DIR. SCOTT HAGGERTY: NO. THAT'S JUST A FACADE OF ME. I RUN A 7 

VIDEO. SO I THINK THAT CHAIR ARREGUIN AND MYSELF HAVE BEEN IN 8 

DISCUSSIONS. WE DID HAVE A MEETING SCHEDULED ABOUT A WEEK -- 9 

MAYBE TWO WEEKS AGO, AND IT WAS A CRAZY COVID DAY. SO WE BOTH 10 

DECIDED WE PROBABLY SHOULD BETTER DO SOMETHING ELSE. AND YOU 11 

KNOW, WE HAVE HAD DISCUSSIONS ABOUT HOW WE'RE GOING TO 12 

APPOINT. I BELIEVE THAT I'M IN A LITTLE MORE DIFFICULT 13 

POSITION THAN THE PRESIDENT OF ABAG. AND THE REASON WHY IS 14 

BECAUSE WE HAVE WEDNESDAY COMMITTEES AND FRIDAY COMMITTEES, 15 

AND SO WHEN I APPOINT A LEGISLATIVE COMMITTEE, I HAVE TO BE 16 

MINDFUL THAT IT'S PROBABLY MEMBERS OF THE FRIDAY COMMITTEE. SO 17 

I MAY HAVE TO MOVE SOME PEOPLE AROUND BETWEEN WEDNESDAY AND 18 

FRIDAY. MY GOAL IS TO NOT DO THAT. BUT I THINK THE PRESIDENT 19 

OF ABAG HAS AN EASIER TIME WHERE HE CAN JUST PICK PEOPLE. HE'S 20 

NOT BOUND BY A DAY OF A COMMITTEE. SO WE'RE GOING TO SIT DOWN 21 

AND WE'RE GOING TO FIGURE OUT HOW TO DO THE APPOINTMENTS. BUT 22 

FROM THE MTC SIDE, I'LL JUST ADDRESS THAT, IF YOU'RE CURRENTLY 23 

SERVING AS A MEMBER OF THE LEGISLATIVE COMMITTEE, I FULLY 24 
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EXPECT THAT YOU WILL STAY THERE. THAT'S MY GOAL. I HOPE THAT 1 

ANSWER YOUR QUESTION JAKE.  2 

 3 

JAKE MACKENZIE: [LAUGHTER] THAT'S FAIR ENOUGH. I MEAN, YOU 4 

HAVE LAID OUT EXACTLY THE CHALLENGES THAT FACE YOU AS CHAIR, 5 

OF MTC, AND I LOOK FORWARD TO CONTINUING TO PLAY A ROLE. AND 6 

THAT'S IT, CHAIR GLOVER. I HAVE SAID MY PIECE.  7 

 8 

FEDERAL D. GLOVER, CHAIR: THANK YOU. ARE THERE ANY OTHER 9 

COMMISSIONERS THAT HAVE QUESTIONS OR COMMENTS?  10 

 11 

AMY R. WORTH: FEDERAL, IT'S AMY, I DON'T KNOW IF YOU CAN SEE 12 

MY HAND.  13 

 14 

FEDERAL D. GLOVER, CHAIR: AMY.  15 

 16 

AMY R. WORTH: THANK YOU MR. CHAIR. I HAVE A COUPLE OF QUICK 17 

THINGS FIRST OF ALL I SHARE JEANNE'S THOUGHTS ABOUT HAVING 18 

MORE MEMBERS THAN A QUORUM OF THE COMMISSION BUT PARTICIPATION 19 

IN THE PREVIOUS DISCUSSIONS IT'S MY UNDERSTANDING -- I DON'T 20 

KNOW HOW WE GET TO 11 COMMISSIONERS FOR THE LEG COMMITTEE. I 21 

THOUGHT AGAIN AS WE CONCLUDED THAT IT WOULD BE PERIL TO SAY TO 22 

THE FRIDAY COMMITTEE. AM I MISSING SOMETHING THAT WE'RE ADDING 23 

TWO PEOPLE. THAT'S ONE THING. SECOND, IT SOUND LIKE WHAT I'M 24 

HEARING FROM STAFF IT SOUND LIKE THERE IS A CLERICAL STRUCTURE 25 
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AROUND THIS TO FIND THE RIGHT NUANCES AND WE JUST HAVE TO FIND 1 

THE RIGHT LANGUAGE TO MAKE THIS HAPPEN. IS THAT WHERE WE ARE?  2 

 3 

THERESE MCMILLAN: THIS IS THERESE, EXECUTIVE DIRECTOR. YES. I 4 

WOULD SAY THAT ONE OF THE THINGS THAT ONE COULD CONSIDER WE -- 5 

CHAIR HAGGERTY, AND PRESIDENT ARREGUIN WERE DISCUSSING HOW WE 6 

WANTED TO MAKE SURE THAT THE SIZE OF THE COMMITTEE DID NOT GET 7 

TOO BIG, BUT THEY WERE ALSO TRYING TO BALANCE, AS THIS IS THE 8 

FIRST CONSOLIDATED COMMITTEE, THE REPRESENTATIONAL 9 

CONSIDERATION THAT WOULD NEED TO BE BROUGHT TO BAY AREA FROM 10 

BOTH SIDES. AND THE TWO MAIN ONES ARE REPRESENTATION ACROSS 11 

THE GEOGRAPHIC AREA OF THE BAY AREA THAT'S, I GUESS, A NO-12 

BRAINER. BUT AS WELL, I THINK THERE WERE QUESTIONS CONCERNING 13 

THE REPRESENTATION OF THE SIZE OF JURISDICTION, AND THE NUMBER 14 

OF CITY REPRESENTATIVES VERSUS THOSE REPRESENTING COUNTIES. IT 15 

HAS BEEN INITIALLY THOUGHT THAT 11 ON BOTH SIDES WAS LARGE 16 

ENOUGH TO ALLOW FOR THAT BALANCING TO BE ACHIEVED. AND NOT 17 

MAKE IT TOO BIG. ON THE OTHER HAND, YOU KNOW, AS THE 18 

DISCUSSIONS ON WHAT THE COMPOSITION WILL BE, HAVE NOT BEEN 19 

FINALIZED, YOU KNOW, THAT NUMBER COULD BE ADJUSTED AS WE 20 

EVALUATE THINGS THAT WERE RAISED TODAY. SO I WOULD OFFER, 21 

PERHAPS, THAT THAT NUMBER 11 BE VIEWED AS, YOU KNOW, VALUABLE, 22 

AS WE ADDRESS THE POINT THAT BOTH I RAISED, AND WHAT 23 

COMMISSIONER BRUINS AND COMMISSIONER WORTH HAVE ALSO RAISED.  24 

 25 
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AMY R. WORTH: OKAY. SO IF I COULD JUST FOLLOW UP THEN. I THINK 1 

IT'S IMPORTANT TO REMEMBER, TOO, WHAT SCOTT HAS INDICATED, 2 

THAT THIS WAS THE GOAL OF BRINGING THESE GROUPS TOGETHER. WE 3 

DO KNOW THAT THESE COMMITTEES ARE MERELY ADVISORY TO THE 4 

COMMISSION, OR TO THE ADMINISTRATIVE COMMITTEE. SO IT'S NOT 5 

LIKE WE'RE CREATING A FORUM WHERE THE FINAL WORD IS SPOKEN. SO 6 

YOU KNOW, AGAIN, AND THIS'S THE SAME THING WITH 7 

REPRESENTATION. I MEAN, I THINK YOU JUST DO THE BEST YOU CAN, 8 

BUT RECOGNIZING THAT BOTH OF THESE, ANY BILL WILL GO, 9 

OBVIOUSLY IN EMERGENCY SITUATION, WE SEE MOST OF THESE BILLS 10 

ARE NOT OUT OF THE BLUE. HAVING SPENT A NUMBER OF HOURS 11 

YESTERDAY ON A CALL WITH A LEGISLATIVE COMMITTEE, WITH SOME 12 

LEGISLATION IN CONTRA COSTA, YOU KNOW, I RECOGNIZE THE 13 

IMPORTANCE OF US BEING NIMBLE IN TERMS OF BEING ABLE TO 14 

PARTICIPATE WHEN BILLS MOVE QUICKLY IN SACRAMENTO. I 15 

APPRECIATE THAT FEEDBACK IN TERMS OF BRINGING THIS INFORMATION 16 

BACK TO THE COMMISSION.  17 

 18 

FEDERAL D. GLOVER, CHAIR: THANK YOU. I HAD SEEN A RAISED HAND 19 

BUT DON'T KNOW WHO THAT WAS. MADAM CLERK, DO YOU HAVE --  20 

 21 

JAKE MACKENZIE: IT WAS ACTUALLY COMMISSIONER MACKENZIE WHO 22 

RAISED HIS HAND AND SORT OF HAD SECOND THOUGHTS. BUT I WAS 23 

GOING TO REACT TO COMMISSIONER WORTH'S REMARKS JUST IN TERMS 24 

OF ACTIONS TAKEN BY OUR MTC LEGISLATION COMMITTEE, AND SEVERAL 25 
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TIMES THIS LEGISLATIVE SESSION -- OR AT LEAST A COUPLE OF 1 

TIMES, WE HAVE UTILIZED THE URGENCY REQUIREMENTS AND AS THE 2 

CHAIR IN CONCERT WITH OUR CHAIR AND VICE CHAIR OF MTC, WE HAVE 3 

RECOMMENDED POSITIONS ON BILLS, SO WE'RE NOT COMPLETELY 4 

TOOTHLESS.  5 

 6 

FEDERAL D. GLOVER, CHAIR: OKAY. ANY OTHER COMMENTS? QUESTIONS? 7 

OKAY. DO WE HAVE ANYONE FROM THE PUBLIC?  8 

 9 

CLERK OF THE BOARD: I SEE NO RAISED -- WELL, WE DO NOW HAVE A 10 

MEMBER OF THE PUBLIC. RICH HEDGES HAS RAISED HIS HAND.  11 

 12 

FEDERAL D. GLOVER, CHAIR: OKAY. MR. HEDGES?  13 

 14 

RICHARD HEDGES: NO PROBLEM WITH THE CONCEPT. I JUST WANTED TO 15 

WEIGH IN ON THE BROWN ACT ISSUE. IF YOU'RE HAVING A -- AND 16 

THIS IS WHAT I THINK. IT DOESN'T MEAN IT'S TRUE. IF YOU'RE 17 

HAVING A MAJORITY OF THE COMMISSIONERS, YOU MAY HAVE TO 18 

ANNOUNCE THE COMMITTEE AS MTC TO DISCUSS ADMINISTRATIVE 19 

ISSUES. BECAUSE I THINK, WHEN YOU HAVE A MAJORITY OF THE BODY, 20 

YOU HAVE TO -- YOU HAVE TO DISCLOSE ITS MAJORITY OF THE BODY 21 

FOR THE BROWN ACT. THANK YOU.  22 

 23 

FEDERAL D. GLOVER, CHAIR: OKAY.  24 

 25 
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CLERK OF THE BOARD: I SO NO ADDITIONAL RAISED HANDS, AND I 1 

HAVE RECEIVED NO WRITTEN PUBLIC COMMENTS.  2 

 3 

FEDERAL D. GLOVER, CHAIR: I THINK THE ACTION IS TO FORWARD 4 

THIS TO THE FULL BODY THAT WOULD COME WITH SOME AMENDMENTS TO 5 

THE DOC THAT'S IN PLACE TODAY. AM I CORRECT IN THAT 6 

ASSUMPTION?  7 

 8 

CLERK OF THE BOARD: I BELIEVE SO, MR. CHAIR.  9 

 10 

FEDERAL D. GLOVER, CHAIR: OKAY. IS THERESE --  11 

 12 

THERESE MCMILLAN: YES I'M HERE. SORRY. YES, MR. CHAIR, IT IS 13 

WITH THAT DIRECTION TO STAFF TO CONTINUE ADDRESSING THE ISSUES 14 

THAT WERE RAISED TODAY, AND BRING FURTHER AMENDMENTS TO WHAT 15 

YOU SEE BEFORE YOU TO THE FULL COMMISSION AT ITS MEETING.  16 

 17 

FEDERAL D. GLOVER, CHAIR: OKAY. SO THAT WILL -- THAT WILL BE 18 

THE ACTION OF THIS BODY. ALL IN AGREEMENT? IF WE COULD HAVE 19 

ROLL CALL.  20 

 21 

CLERK OF THE BOARD: YES. COMMISSIONER -- DO WE REQUIRE A 22 

MOTION AND A SECOND FOR THAT?  23 

 24 

ADRIENNE WEIL, COUNSEL: YES. CAN WE HAVE A MOTION?  25 
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 1 

THERESE MCMILLAN: YES.  2 

 3 

FEDERAL D. GLOVER, CHAIR: SO WHO CALLED FOR --  4 

 5 

AMY R. WORTH: MR. CHAIR, I WILL CALL FOR THAT. I'LL MAKE THAT 6 

MOTION, BUT WITH THE CLARIFICATION, I THINK, THAT OUR 7 

EXECUTIVE DIRECTOR PROVIDED THAT THERE REMAIN SOME ISSUES THAT 8 

NEED TO BE CLARIFIED AND RESOLVED, AND THEN A NEW 9 

RECOMMENDATION WILL COME BACK TO THE COMMISSION. SO WE'RE -- I 10 

THINK IT'S REAL CLEAR THAT WE'RE NOT REALLY OPINING ON THE 11 

RECOMMENDATIONS THAT ARE BEFORE US BUT WE'RE MERELY MOVING THE 12 

PROCESS BACK TO STAFF FOR STAFF TO DO FURTHER ANALYSIS TO 13 

BRING FOR POTENTIAL NEW CONCEPTS? IS THAT CORRECT THERESE?  14 

 15 

THERESE MCMILLAN: YES. AND SPECIFIC TO THE ISSUES I RAISED AS 16 

WELL AS THE PRESENCE OF THE GOVERNING BODY AS A COMMITTEE, 17 

THAT QUESTION THAT WAS RAISED BY YOU AND COMMISSIONER BRUINS.  18 

 19 

AMY R. WORTH: EXACTLY. OKAY. PERFECT. GREAT. THANK YOU.  20 

 21 

FEDERAL D. GLOVER, CHAIR: DO I HAVE A SECOND?  22 

 23 

GINA PAPAN: PAPAN SECOND.  24 

 25 
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FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. AND WE HAVE ROLL 1 

CALL VOTE, PLEASE.  2 

 3 

CLERK OF THE BOARD: YES. [ROLL CALL VOTE]  4 

 5 

JEANNIE BRUINS, VICE CHAIR: I'M GOING TO HAVE TO ABSTAIN AT 6 

THIS POINT MY QUESTIONS ARE RAISED TO A LEVEL THEY CAN'T 7 

EMBRACE IT YET.  8 

 9 

CLERK OF THE BOARD: THANK YOU. [ROLL CALL CONTINUED] THANK 10 

YOU. MOTION PASSES WITH ONE ABSTENTION.  11 

 12 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU. WE WILL NOW MOVE TO 13 

OUR NEXT ITEM, WHICH IS THE PUBLIC COMMENT. AND WE WILL ASK 14 

THE CLERK IF THERE WERE ANY PUBLIC COMMENTS RECEIVED BEFORE 15 

FIVE YESTERDAY?  16 

 17 

CLERK OF THE BOARD: NO, MR. CHAIR, THERE WERE NO WRITTEN 18 

PUBLIC COMMENTS RECEIVED AND THERE IS ONE MEMBER OF THE PUBLIC 19 

WITH A RAISED HAND. MR. ROLAND LE BRUN.  20 

 21 

FEDERAL D. GLOVER, CHAIR: WE WILL TAKE THAT NOW.  22 

 23 

CLERK OF THE BOARD: THANK YOU.  24 

 25 
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SPEAKER: GOOD MORNING COMMISSIONERS. THIS IS ROLAND IN SAN 1 

JOSE. I HAVE JUST BEEN ENJOYING YOUR OUTSTANDING NEW 2 

TRANSCRIPT FEATURE. AND I'M WONDERING IF IT WOULD BE POSSIBLE 3 

TO ARCHIVE THESE TRANSCRIPTS IN LEGISTAR, NEXT TO THE VIDEO. 4 

THANK YOU.  5 

 6 

CLERK OF THE BOARD: I SEE NO ADDITIONAL RAISED HANDS MR. 7 

CHAIR.  8 

 9 

FEDERAL D. GLOVER, CHAIR: OKAY. THANK YOU FOR THE COMMENT, 10 

ROLAND, AND AT THIS TIME, THIS MEETING WILL STAND ADJOURNED. 11 

OUR NEXT MEETING IS SCHEDULED TO BE HELD WEDNESDAY SEPTEMBER 12 

9TH. AT THE BAY AREA METRO CENTER, REMOTELY. THANK YOU. WE ARE 13 

ADJOURNED. [ADJOURNED]  14 

 15 


